
Select your server from the drop-down list

Click Select and Sign In

Signing In to Meeting Maker

Real-Time Internet Scheduling for Macintosh, Windows, UNIX, and Java

Click on the Single
Day/Multi-Day icon to switch

between a single day view
and the weekly view.

Java ClientJava Client -
Select the Daily Calendar by

clicking on the Daily View icon.
Select other calendar views by
clicking on the appropriate icon.

Q U I C K  R E F E R E N C E

Click on Server and select an appropriate protocol 
(TCP, IP, Appletalk, or IPX)

Double-click the Meeting Maker icon.

If you don’t see a
server listed, follow
the steps below:
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Type your sign in name and password, and click
Sign In
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Click on your browser and select the URL
to access your Meeting Maker Java Client.
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Click in the empty space next to Name,
type your sign-in name and password, and
click Sign In
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Meeting Maker Daily Views

Meeting Maker lets you maintain your calendar, prioritize a To-Do list, arrange meetings, and
coordinate your schedule with anyone on the network or over the Internet.

Native ClientNative Client - 
Select Daily Calendar from
the View menu to view your

calendar by day.

Native Client Login Java Client Login

For TCP or IP you will need to click Configure to enter the IP address or 
domain name of the Meeting Maker server. See your administrator for details.

ON Technology Corporation
http://www.MeetingMaker6.com



Proposing Meetings or Activities

Option or Control, click and drag the mouse across the
time you wish to schedule a meeting.  Click and drag for
an activity, or select File , New Activity/Propose Meeting .

Click Schedule and select a time when all
guests can attend, or click Auto-Pick and let
Meeting Maker find the first time when all
required guests are available.

Click Guests and select All Users to invite people
to a meeting.  Click Guests and select Locations
to reserve a room for the meeting.

Double-click the message to read the invitation.

Click Yes, No or I’ll decide later , and click Reply.

Choose View, then Messages .  New invitations
will be listed in the Active Messages folder.
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Click Send Proposal to send the meeting
proposal.

Type a meeting title or activity description.2
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NOTENOTE:  :  The difference between meetings and activities 
is that meetings include guests or resources, and activities
involve only yourself.
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Additional Meeting/Activity Scheduling Options
A. For recurring meetings/activities, click Frequency , and select

from the available options.

B. Click the Options button to set up an automatic       
reminder of the scheduled event, or to define
the status of the meeting (i.e., private, flexible).

C. Click the Agenda/Notes/Comments button to include 
additional information. The Java Client has the added ability to
include url links; i.e.  http://www.meetingminutes.com.

Meeting Invitations
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Note: Meeting Maker automatically defaults to answer Yes or No based
on your current availability for the specified date and time.  You may wish
to over-ride the default.  For example, if you were already booked at that
time, Meeting Maker will suggest No as the response, but you could
change it to Yes if you wish to attend the newly proposed meeting.



Note: Type-ahead in the user list to quickly locate the 
individual(s) you wish to invite to a meeting.

For recurring meetings or activities, click
Frequency , and select from the available options.

Java Client Meeting Proposal

Option or Control, click and drag the mouse
across the time you wish to schedule a meeting;
click and drag for an activity, or select File , then
New Activity/Propose Meeting .

Click the Guests Tab, then double-click All Users,
Locations or Resources to invite people to the
meeting, and reserve a room and/or equipment for
the meeting.
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Type a meeting title or activity description.2
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Click the Schedule Tab and select a time when all
guests can attend, or click Auto-Pick and let
Meeting Maker find the first time when all required
guests are available.
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Note:Busy-time is graphically presented within the schedule tab for both
required and optional guests, as well as locations and/or resources. 
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Create url links in the Agenda , Notes or Comments Tab6

Click on the Option Tab to set reminders and Labels7

Options/Preferences
Options, such as labels, default reminder settings, and other calendar
preferences are set at the native client level, however there are some
preferences, such as burn-through notification and font settings that can
be set from within the Java Client.  Burn-though notification can be
turned on/off per browser session (when the first reminder occurs).
Font preferences can be changes by holding down Ctrl-Shift and click
into the toolbar.  Logout of the Java session to completely enable new
font settings.



Double-clicking within the “open area” of any ‘title-bar” will col-
lapse the window. Double-clicking the title bar again will restore
the window.

A banner is an informational item that usually does not correlate to a
specific time of day. Examples include a trade show, a colleague’s
vacation, or a birthday. By default a banner is what Meeting Maker
calls Flexible , and it does not block busy-time. You can also use a
banner to reserve busy time. In this case, a banner would indicate
that you are attending a trade show and are not available for meet-
ings. Banners can span multiple days, and you can have several
banners on the same day.  Banners appear in both the daily and
monthly calendar views of the Meeting Maker native client.

To create a banner click and drag the mouse across the banner
display region, located above the daily view, or choose File,
then New Banner.

Enter a title and location for the banner.

Click Schedule to modify the date range.

In the Daily view, banners appear in area above the
splitter bar. The clock icon denotes that busy-time is
being reserved (non-flexible banner).

On a Monthly Calendar, the banners appear as flags.
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Banner Options:
Set automatic reminders  and/or labels
Mark your banner Private, Publishable, or Flexible 

Java Client Navigation & Proxies 

Navigation & Desktop Organization :
Double-clicking within the “open area” of the toolbar reduces the size of the toolbar, thus providing more space within the browser to
work with calendar information.  Double-clicking again within the small toolbar “open area” will restore the toolbar to its original size.
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after user’s name.  Select the
proxy you wish to access and
click open (or double-click the
proxy).  Note: Proxies can only
be opened one at a time, how-
ever you can have multiple
proxies open within your
browser.  See Native Client
Proxies for more information.

Accessing Proxies:
Click the Proxy icon on the toolbar.  All Proxies will be listed in
alphabetical order.   Read/Only proxies are noted with a “(R)”  

Banners



Choose View, then To-Do List .

Click New to create a new To-Do item.

Enter a To-Do title and date and select a priority

Create a Group To-Do by clicking on Participants
and select the users you wish to have review and/or
complete this task.

Note: Priorities can be customized from the Edit Preferences menu

Master Schedule

3

Creating a To Do & Group To Do
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Master Schedule provides a composite view of busy and free time for a defined group.  Groups can
be setup as either personal groups, public groups, or global groups.  Create a personal group by
selecting Edit , Address Book , then New Group .  Add users and/or resources to the group and from
the View menu select Master Schedule and pick the group that you created. Master Schedule prefer-
ences can be set by clicking on the Edit menu and selecting Master Schedule from the preferences
window.  The default view can be set to show anywhere from 1 -7 days.  The color scheme can be
customized to graphically display busy-time, work hours (free-time) and non-work hours in a way that
is easy for you to recognize at a glance (examples: red/green/yellow or red/dark grey/light grey). The
Master Schedule Group bar indicates the free and busy time of the group as a whole.  Instantly
invite the entire group by clicking and dragging the mouse across the group bar at the desired time.

Click on the
Reminder panel
to set a reminder
and receive a
notification for
the To-Do item.

Selected participants will receive a To-Do
proposal that appears in the Messages Window 
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Open the specific item and mark a
completed To-Do Done or click
Done in the To-Do List window

Master Schedule Shortcuts
1. Propose a meeting for Read/Write
proxied users or resources.
Shortcut - Hold down the Option
key(Mac)/Ctrl (Win) while dragging on
the work hours area of that user or
resource’s row.

2. Propose a meeting for Read-Only
proxied users or resources.
Shortcut - Drag on the work hours area
of that user or resource’s row.

3. Schedule an activity for a Read/Write
proxied user or resource.
Shortcut - Drag on the work hours area
of that user or resource’s row.

4. View activity or meeting details of a
Read/Write proxied user or resource.
Shortcut - Double-click on the busy-
time block in that user’s or resource’s
row.

5. View any proxied user’s or resource’s
Daily Calendar. 
Shortcut - Double-click on the user or
resource name.

Notes: You must be working online
to use a Master Schedule.  Master
Schedule is only available in the
Native client.  Users who have
given you proxy rights show with a
pencil next totheir name.



You can designate another user as your Proxy (someone with access to your calendar). Proxies can track your
meetings, activities, To-Dos, and can print your calendar.You can make specific Activities and To-Dos private to
keep proxies from viewing them.

Choose Edit, Proxy List .

Select proxies from the Users list and click either
Read/Write or Read-Only .

Read/Write proxies can change your calendar.   Read-
Only proxies can only view the proxied calendar.

Click OK to enable the selected proxies.

Private Activities :

When proxying a
calendar, this sym-
bol indicates that
the user has desig-
nated the activity as
“private”.

Note : To work on someone’s calendar when you’re a
proxy, choose the user’s name from the Proxy menu. To
return to your calendar, choose your name from the Proxy
menu. Look at several calendars simultaneously by select-
ing Tile Daily from the View menu.

Click here to select a proxy to receive your
message notifications (optional).
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Creating Contacts

You can create a contact list that includes both external and internal contacts by entering data on the Contact
Information screen. Once you create a Contact List, you can access it from the Meeting Proposal screen in
order to invite the contact person to a meeting.

Choose View, then Contact List . The Contact List
screen appears.

Click Create . The Contact Information Entry
Screen appears.

Enter the contact data.
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Click OK to add the new contact to the Contact List.4

Native Client Proxies & Navigation

Contacts in the native
client can be created,
deleted and/or modified to
send a meeting proposal
via email (SMTP or
MAPI).  In the guest panel
of a proposal click on
Public Directory, then
Contacts, select the indi-
vidual(s) you wish to
invite as guest and send
the meeting proposal.

Contacts in the Java client can
be accessed via a meeting pro-
posal. A meeting proposal can
be sent via email (SMTP/MAPI)
by selecting a contact from the
Public Directory in the guest tab
and inviting the Contact(s) as
guest.  Cut/copy and paste from
the Info field to the Agenda or
Comments  text fields.

Calendar Navigator:
Click on the navigator icon to
select a date to display on your
calendar, or enter a specific
date to jump forward to on your
schedule. See also Shortcuts
section on last page.

Native Client

Java Client



Click Options on the Print Schedule window.

Click one of the calendar views from the list on the
left.

Changing Calendar & Print Options...

Click the calendar and print options that you want to
incorporate into the printed document, Click OKNote: When printing a meeting or message from the file

menu, print options, such as Agenda, User Name, etc.
are governed by options set in the Event Text form.
This also applies to the form: Tri-Fold - w/Event Text.
The Tri-Fold - w/To-Do List is also governed by the
print options that are set in the To-Do list form. 
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Page Layouts
Click Page Layout on the Print Schedule window.
Choose from a variety of print layouts, such as
DayRunner, Day-Timer and Franklin Quest.

Layout of the selected
view appears here.

Native Client Printing Options

Select the form, enter a start and end date, Click OK

Palm OS Synchronization

Meeting Maker 6 allows users with Palm OS devices to synchronize directly with Meeting Maker Mac or Win
clients. Synchronize your Calendar/Date Book, Contacts/Address Book and/or To-Do List information directly
with Meeting Maker.  If you already have the Palm Desktop/Mac Pac software installed on your workstation,
once installed, the Meeting Maker Palm Conduits will replace the default Palm or third-party conduits.  

Users can choose to install only specific conduits, if, for example, they wish to use other conduits in conjunction with
Meeting Maker.  After installation of the Meeting Maker Palm Conduit(s), restart the Conduit Manager(Mac) or Hotsync
Manager(Win).  By double-clicking on one conduit and entering your Login Name, Password, and Meeting Maker
Server name, the other two conduits will automatically populate with the appropriate information.

Note: Information on configuration and setup of the Palm Conduits can be found
in the User Guide and/or at http://www.MeetingMaker6.com.
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Java Client Printing Shortcuts

Choose File then Print Schedule .1

Daily View
Click on a specific event and use Ctrl-P to print
that event.

Monthly View
Click on a day  and use Ctrl-P to print all
events for that day.



User invited as a required guest

User invited as a optional guest

Guest busy at proposed meeting time

Status unknown (no server connection)

Meeting scheduled outside of guest’s normal
work hours

User receives a (cc) copy of the meeting proposal

User receives a (bcc) copy of the meeting proposal

Guest has accepted your meeting invitation

Guest has declined your meeting invitation

Guest has postponed response (I’ll decide later)

Public, Private or Global Group

Room

Equipment

Confirmed meeting

At least one guest declined your meeting proposal

Activity

Notes or comments are attached to the activity or
meeting proposal

Connected to the server

Disconnected from the server

Working offline

To-Do item you proposed or a personal To-Do item

All participants have accepted the To-Do proposal

At least one participant has refused the To-Do
proposal

To-Do proposal Status is unknown

Comments were added to the To-Do proposal by a
participant

Completed To-Do item

Completed group To-Do item

Message regarding changed To-Do item

New Meeting Proposal or To-Do request

Message regarding rescheduled meeting

Message regarding canceled meeting

Confirmed meeting

Message regarding changed meeting

Guest has declined your meeting invitation

Guest List User List

To-Do List

Daily Calendar

p/n:  010-QRC-0302

?

View Menu Daily Calendar Ctrl+D
Monthly Calendar Ctrl+Y
Messages Ctrl+E
To-Do List Ctrl+T
Go to day Ctrl+G
Find Ctrl+F

Tile Daily Ctrl+I

Proxy Menu Proxy 1 (You) Ctrl+1
Proxy 2 Ctrl+2
Proxy 3 Ctrl+3

Keyboard Shortcuts

File Menu New Activity/To-Do Ctrl+N

Propose Meeting Ctrl+M

Open a selected Ctrl+O
Meeting, Activity, or To-Do 

Close a selected Ctrl+W
Meeting, Activity, or To-Do 

Print Schedule Ctrl+P
Sign Out Ctrl+L
Exit/Quit Alt+F4
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Monthly Calendar

Banner symbol in the monthly view

Message Window

N
M
O

W

P
L
Q

D
Y
E
T
G
F

I

1
2
3

Meeting Maker Symbols

Other Shortcuts:   Copy Activity/Meeting CTRL-drag Option-drag Other Shortcuts:   Calendar Navigation   CTRL-Click  Option-Click

Visit our website at http://www.MeetingMaker6.com for more detailed information including:
a step-by-step User Tutorial (in HTML), documentation, FAQs, and technical support bulletins.


